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A SPY’S SOJOURN 
At the request of our army’s Marshal, | have ventured into 
enemy domain. My path has taken me across woods and 
lakes under the cover of darkness, and around black mines — 
looming like markers of death before me. 

The enemy’s war councils are at a frenzied pitch; messen- 
gers scuttle between the camps. Scouts prepare to unearth 
our most precious secrets. | have seen Captains and Colo- 
nels in bivouac, their plumed helmets circling the night fire. | 
have eavesdropped on Majors, and watched Miners practice 
defusing bombs. | 

| once approached the fire where our enemy’s Marshal sat 
with his General, wrapped in overcoats of winter. Focused 
on the great map, their eyes gleamed confidently as the 
smoke rose high. Their voices were mere niepers as they 
drew up the final plans. 

Had | been detected, the execution of my fate would surely 
have been swift. Yet, | worked in the absence of undue 
haste, Knowing the value of my report. Nothing would sad- 
den me more than to have returned flush of cheek, yet 
bearing but a sketch in the sand, to be washed away in the 
incoming tide. 

If our forces be sure in the execution of our plans, the 
enemy’s doom is surely sealed. 
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OVERVIEW 
Stratego, adapted from the popular board game of the same 
name, is a contest of wills between two evenly-matched 
armies meeting on a rugged battlefield. The game empha- 
sizes careful planning, thorough deception, and well-timed 
boldness. The object is to capture the opponent's flag 
before he captures yours. 

Skillful play depends upon the application of memory. At 
first, guesswork prevails. Each side probes the other’s 
defenses, seeking to reveal the identity of key pieces, un- 
cover mines, locate spies, and discover likely attack routes. 

When you reveal an opponent’s piece, you mentally record 
its location. Memory plays an increasingly important role as 
a game progresses and as your opponent shuffles his pieces 
to and fro. Move matches countermove as the battle unfolds 
to its necessary climax. 

Each battle is different — even those which feature similar 
army formations. Each demands your full attention, and 
presents new challenges. To capture your opponent's flag, 
you must have an adventurer’s spirit and a tactician’s mind. 
This is the essence of Stratego. 
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GETTING STARTED 
In this section, we describe the nuts-and-bolts of getting 
started: system requirements, installation, disk backup, 

~ booting, and copy protection. 

System Requirements 
Stratego runs on any member of the Macintosh family of 
computers with at least 1MB of RAM and 128K of ROM. 
The game requires System 4.2 or later. 

User Requirements 
Before you start playing the Macintosh version of Stratego, 
you should know how to: 

¢ Use the icons on the Macintosh desktop. 
¢ Open and close Macintosh documents and folders using 

the Finder. 
¢ Point and select with the mouse, and understand basic 

Macintosh terms and techniques such as click, double- 
click, and drag. 

¢ Scroll in a window or list box using the scroll bars and the 
scroll box. 

¢ Pull down menus and choose commands. 
¢ Find files in the hierarchical file system. 

You should also understand Macintosh terms such as dialog 
box, list box, folder, and button. For information on any of 
these items, see your Macintosh owner’s guide. 
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Installation 
Stratego comes with two disks. If you’re playing in Black & 
White, you only need Disk 1. If you’re playing in Color, 
you'll need both disks. 

To install Stratego to your hard drive: 

1 Create a new folder on your hard drive. 
2 Insert Stratego Disk 1 in the disk drive. 
3 Double click on the Stratego disk icon to open a display 

of the disk’s contents. 
4 If you’re playing in Black & White, drag these game files 

— Stratego, Stratego Help and Stratego Sounds — 
from the Stratego disk to the new folder. | 

If you’re playing in Black & White, you’re ready to boot the 
game from the hard disk. If you’re playing in Color, read on: 

5 Drag the Color Data 1 game file from Disk 1 to the 
new folder. 

6 Now eject Disk 1, and put Disk 2 in the disk drive. 
7 Double-click on the Stratego disk icon to display the 

disk’s contents. 
8 Drag the Color Data 2 game file from Disk 2 to your 

Stratego folder. 

Backup 
We recommend that you back up your copy of Stratego 
before beginning play. Copy the game files to a blank, 
formatted and labelled 3.5" disk. (For disk copy procedure, 
consult your Macintosh owner’s guide.) When you're done, 
place your original disk in a safe place. 

Starting Stratego 
If you have a hard drive system: 

1 Turn on your computer. 
2 Open the folder that you created containing the Stratego 

files. (See Installation above.) 
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Double-click on the Stratego application icon. 
When the “Spy’s Secret Report” appears, consult your 
codewheel to decode it (see Spy’s Secret Report 
below). 
The title screen appears, and Stratego’s theme music 
plays. When the game board appears, begin Game 
Setup (see the Game Setup section for more). 

If you have a floppy disk drive system: 
1 

2 

Put your system disk in the disk drive and turn on your 
computer. 
Put Disk 1 into the disk drive and double-click on 
the Stratego disk icon to open a display of the disk’s 
contents. 
Double-click on the Stratego application icon. 
When the “Spy’s Secret Report” appears, consult your 
codewheel to decode it (see Spy’s Secret Report 
below). 
The title screen appears, and Stratego’s theme music 
plays. When the game board appears, begin Game 
Setup (see the Game Setup section for more). 

Spy’s Secret Report 
Stratego uses the “Spy’s Secret Report” and a codewheel as 
copy protection. When the Spy’s Report appears, your 
screen will show four elements — two icons, two words — 
and a box to type in. 
1 

2 

Match the left-most icon on the screen to the same icon 
on the outer ring of the codewheel. 
Now find the second icon from the left on the screen, and 
match it to the same icon on the middle ring of the 
codewheel. 
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Spy’s Secret Report (continued) 
3 Rotate the middle ring so the second icon lines up under 

the first icon. 
4 Next, find the left-most word on the screen, and match it 

to the same word on the edge of the inner ring of the 
codewheel. 

5 Rotate the inner ring so the word is lined up under the 
two icons (which are already matched and lined up). 

6 Look for the second word on the interior of the inner ring; 
there is a number in the cut-out window immediately 
above the word. 

7 Type in that number and press Return. The game will 
now load. 

GAME SETUP 
Stratego begins with two armies of forty pieces facing each 
other on a square field of battle. Two lakes in the center 
of the board divide it into halves. The computer's pieces 
occupy the top half, while your half is empty until you choose 
a setup for your army. 

Your pieces occupy the piece box at screen right, which 
empties when you complete your setup procedure. During 
play, pieces lost are returned to the piece box. 

Choosing Board, Background and 
Piece Sets 
Both the Black & White and Color versions of Stratego let 
you choose from among several different boards, back- 
grounds and piece sets. Just pull down the Options menu 
and choose the following: 

Board... ) 

The Board... option lets you change either the Board Type 
or the Background Fill. 



Fig. 1. Choose Board/Background Screen 

¢ Tochange the Board Type, click & hold on the box that 
lists the current board type; this displays a pop-up menu 
that lists other available board types. While still holding 
down the mouse button, move the cursor arrow to the 
board type you want, then release the mouse button. A 
portion of the new board will appear in the Preview Box. 

¢ To change the Background Fill, click & hold on the box 
that displays the current piece box background pattern/ 
color; this displays a pop-up palette that shows other 
available patterns/colors. While still holding down the 
mouse button, move the cursor arrow to the background 
you want, then release the mouse button. 

Color Macintosh owners may also modify the color of the 
Background Fill by clicking on Choose Color...and then 
adjusting the color using the color circle. 

After either choice, you must click on OK to enact the 
change, or Cancel to return the board/background 
settings to what they were before you opened the Board... 
dialog box. 
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Fig. 2. “Choose Piece Set” Screen 

Piece Set... 
The Piece Set... option lets you change piece sets for game- 
play. Just click & hold on the box that lists the current piece 
set; this displays a pop-up menu that lists other available 
piece sets. While still holding down the mouse button, move 
the cursor arrow to the piece set you want, then release the 
mouse button. Samples of the new set will appear in the 
Preview Box. 

Color Macintosh owners may also click on the Color Pieces 
box to enable selection of black & white pieces. 

Choosing a Setup 
You can set up your army’s pieces in any of the following 
ways: 

¢ Click and drag individual pieces from the piece box to 
empty squares on your half of the game board. Continue 
until all pieces have been placed on the game board. 

« Select Open from the File Menu to select a saved setup 
you've previously created. 



¢ Select a “packaged” game setup by choosing Use 
Setup... from the File Menu. Scroll to view the available 
setups, and select one. Choose the Flag Orientation 
(left or right). All forty pieces are placed automatically on 
the board. 

¢ Choose either Use Setup... or Open, then modify an 
existing setup by redistributing individual pieces. To 
replace a piece (let’s call it piece “A”) with another piece 
(piece “B”), do the following: 

exally Move piece “A” to the Piece Box. 
2 Move piece “B” to the empty square left by the removal 

of “A”. 

You can move any number of your pieces from the board to 
the Piece Box in the course of modifying an existing game 
setup. 

Opponent Level 
You can set your opponent’s skill level before starting a 
Single Game or the first game of a Campaign. The default 
selection is Sergeant, a good choice if you’ve never played 
Stratego before. As your own skill increases, you may want 
to use Opponent Level to raise the level of your opposition. 

To set your opponent's level: 

1 Pull down the Game Menu and highlight Opponent 
Level. 

2 When the adjacent pull-down menu appears, select one 
of the five skill levels. In order of increasing difficulty, 
they are: 

Sergeant 
Major 
Colonel 
General 
Marshal 
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Opponent Level (continued) 
3 During play, your opponent’s skill in tactics and strategy 

will reflect the level selected. 
4 The Opponent Level you select remains in effect for 

ensuing games. You can raise or lower the level before 
the start of any new game. 

Pieces and Ranks 
You begin play with forty pieces in your army. 33 of these 
are moveable, and are ranked from #1-9/Spy. Of the re- 
maining seven, six (6) are Bombs, and one (1) is your Flag. 
These seven pieces cannot be moved once play begins. 

Each moveable piece is ranked. Powerful pieces (e.g., the 
Marshal) are assigned low number ranks, while those with 
less clout have higher number rankings. 

The moveable pieces, their names, quantity and ranks are: 



Rules of Rank 
The rules of rank are as follows: 

* Order of Rank. A Marshal (#1) outranks a General (#2), 
and so on. A Spy is the lowest-ranking piece. 

¢ Special Miner Privilege. A miner defuses a bomb by 
striking it. All other pieces are lost when attacking 
bombs. The miner then occupies the bomb’s former 
square. 

¢ Special Scout Privilege. Scouts can move any number of 
available open squares (in any direction but diagonally). 
When you select Move & Attack (see Preferences... 
in the Playing Stratego section), the Scout can cap a 
multiple-square move by attacking an opponent’s piece. 
But remember: Moving a Scout more than one square 
immediately discloses its identity. 

¢ Special Spy Privilege. Since the Spy lacks numerical 
rank, any piece attacking it causes the Spy’s removal 
from the game board. However, the Spy can remove 
a Marshal from play ifthe Spy attacks first. 

PLAYING STRATEGO 
Once you’ve chosen a setup, you're ready to match wits 
with your opponent on the field of battle. Play begins when 
you move one of your front-row pieces towards the 
opponent’s ranks. The first player to capture the 
opponent’s Flag wins the game. 

During play, you alternate turns with your computer oppo- 
nent. When it’s your turn, you either (1) move a piece into 
an empty square, or (2) attack an opponent’s piece. 

If you’re new to the game, we recommend that you play a 
Single Game using Standard Rules (both found in the Game 
Menu). Once you’ve gained a measure of experience, 
proceed to Campaign and Tournament play. Use the Game 
Menu to change the type of play. 

9 
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Standard Rules 
You'll typically use the Standard Rules (the Game Menu) 
when playing Stratego. The standard rules are faithful to 
the Stratego board game’s rules for movement, attack and 
so on. 

At other times, you may want to use special Preferences or 
Tournament Rules; see the Preferences... and Tournament 
Rules sections at the end of PLAYING STRATEGO for 
more information on activating these rules options. 

Moving Pieces 
During each turn, you move one of your pieces one square 
at a time—with the exception of the Scout. 

These specific rules apply to movement in a Standard Rules 
game: 

- You can move a piece forward, backward, or sideways — 
but not diagonally. Pieces cannot move onto or jump 
over either of the “lakes” in the center of the board. 

* Two pieces may not occupy the same square 
simultaneously. 

* No piece (including Scouts) may move through or jump 
over an occupied square. 

¢ The Flag and Bombs cannot be moved during play. 
¢ A piece cannot move back and forth between the same 

two squares in three consecutive turns. 
* No player can “pass” a turn; a player unable to move any 

of his pieces forfeits the current game. | 

Attacking the Opponent 
Your piece can attack an opponent’s piece when they 
occupy adjacent squares. However, a piece bordering on 
an enemy’s piece is not required to attack. 

To attack your opponent, simply move your piece onto 
the enemy-occupied square. 

10 



When you attack an opponent's piece, the ranks of both 

pieces are revealed. The higher-ranked piece (bearing 

the lower number) wins the engagement, and the loser is 
removed from the board and placed in the Piece Box. When 
equals collide, both are eliminated from play. 

In Standard Rules, a victorious attacker occupies the square 
of his vanquished foe, while a triumphant defender stays in 
his square. (See Preferences... below for an exception to 
this rule). 

Winning a Game 
When one of your pieces moves onto the square where the 
opponent’s flag sits, you win the game. You lose if the 
opponent captures your flag. 

Another victory condition ensues when the opponent is 
unable to move any pieces, though you have yet to capture 

his flag. Should you find yourself in the same predicament, 

you lose. 

Preferences 
You can vary the Standard Rules by selecting Preferences... 
from the Game Menu. 

Fig. 3. Game Preferences Dialog 

4s 
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Preferences (continued) 
To set special game or rule preferences: 

1 Pull down the Game Menu and select Preferences... 
2 When the Game Preferences window appears, view the 

default selections. 
3 Change game or rule preferences by clicking on the 

4 

Ss 

button next to the preference you want to choose. 
When you're satisfied with the new preferences, click 
on OK. 

Here are the rule preferences you can choose: 

¢ Scout’s special move. If you choose Move & Attack, 
your Scout can make a multiple-square move and attack 
on the same turn. Move Only lets your Scout make mul- 
tiple-square moves, but he cannot attack at the end of 
such moves. He can only attack in the same manner as 
other pieces, by moving one space during a turn onto an 
adjacent enemy- occupied square. 

¢ When defender wins. When a piece is We and 
wins the encounter, Standard Rules dictate that it stays in 
its own square (the default setting). But you can also 
choose the Move to Attacker’s variation — if the defender 
wins an encounter, it automatically moves into the 
attacker’s square. 

You can also use the Preferences ... option to change 
game preferences: 

° Player army. Lets you change the color of player 
armies. 

¢ Sort pieces by... Choose Capture Order to place cap- 
tured pieces on the Piece Board in the order they were 
defeated in battle. Choose Rank Order to display cap- 
tured pieces in order of their rank, from highest to lowest. 

Selected rule preferences apply for the duration of the 
ensuing game. However, you can change piece colors 
during a game. 

12 



Tournament Rules 
When you’re ready for the extra challenge which experience 
demands, you can select one or more of three tournament 
rule variations (only available when playing a single game). 
To activate tournament rules: 

1 Select Tournament Rules from the Game Menu. 
2 When the Tournament Rules dialog appears, click on the 

box adjacent to the rule(s) you wish to apply to play. 

You deactivate tournament rules before the start of any 
game by deselecting any of the rules in the Tournament 
Rules dialog, or by selecting Standard Rules. Once you 
begin play, the rules are set for the duration of the current 
game. 

The Tournament Rules options are: 

Aggressor Advantage. When activated, awards victory to 
the attacking piece when equally-ranked pieces do battle. 

Silent Defense. When selected, Silent Defense conceals 
the identity of the piece attacked. The rules for winning the 
engagement do not change. Exception: When a Scout 
attacks, the rank of the defending piece is revealed. 

Rescue. When Rescue is active, you can rescue a captured 
piece by moving onto a square in your opponeni’s back row. 
Now, select a piece from the piece box and place it in an 
empty square on your half of the game board. These restric- 
tions apply: 

¢ Scouts cannot rescue other pieces. 
¢ You can’t rescue bombs. 
¢ You may rescue a maximum of two pieces during 

a game. 
¢ If you make two rescues during a game, two different 

pieces must execute the rescues. 

13 
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Campaign 
Unlike a Single Game, a Campaign consists of five “battles” 
— individual games whose combined results determine the 
outcome of the campaign. Naturally, each successive battle 
in a campaign is more taxing; each battle also uses different 
Tournament Rules (see Tournament Rules on page 13). 

To win a campaign, you must win each individual battle. 
When you lose any game, the campaign is over. 

To start a campaign: 

1 Pull down the Game Menu and select Campaign. 
2 Choose New Game or Use Setup... from the File Menu 

to begin the campaign’s first battle. 

If you choose Single Game while a Campaign is in progress, 
youll be prompted to save the current campaign. 

Here are the Tournament Rules that apply to each game 
within a Campaign: 

14 
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The Statistics Box 
The Statistics Box displays various bits of information that 

you may find useful in the course of the game. Pull down 

the Options Menu, then use the Display Windows sub-menu 

to show or hide the Statistics Box at any time. 

— Campaign 

~~ Pieces Remaining 

—— Rescues Remaining 

~~ Tournament Option Indicators 

Fig. 4. Sub-Screen Shot of Statistics Box — 

Rank 
Displays the rank of the piece you are moving. 

Turn 
Indicates the number of turns taken thus far in the game. 

(A “turn” includes both your move and your opponent's 

matching move.) 

Campaign 
lf you are playing in Campaign Mode, this indicator tells you 

where you are in the 5 game series. 

15 



Tournament Option Indicators 
The small indicator boxes below A, D and R (see Fig 4) light 
up whenever the corresponding Tournament Rule is active: 

A = Aggressor Advantage 
D = Silent Defense 
R = Rescue 

Rescues Remaining 
The number (see Fig 4) indicates how many rescues each 
side has left. 

Pieces Remaining 
Shows the number of pieces still active (see Fig 4) for 
each side. 

16 



APPENDIX: MENU OVERVIEW 
There are five menus in the Stratego menu bar: the Apple 
Menu, File Menu, Edit Menu, Game Menu, and Options 
Menu. Each contains one or more items or commands 
relevant to game play. 

The individual menus and the options applicable to the 
game are: 

Apple Menu 
You use the Apple Menu to get information about aspects of 
Stratego. 

¢ About Stratego: Select this to review game credits. 
¢ Help: Choose Help to view a full list of Help topics 

during play. 

File Menu 
Use the File Menu to reset the board for a new game, 
choose from existing board setups, and manage game files. 

¢ New Game: Select New Game to reset the pieces and 
the game board for a new game. If a game is in prog- 
ress, you are prompted to save the current game. 

¢ Use Setup...: Choose Use Setup... to view a list of 
Stratego’s preset setups for your army. (The computer 
sets up its side independently.) When you choose one of 
these setups, your pieces are placed automatically. 

¢ Open...: Select Open... to return to previously saved 
games or setup files you’ve created. Play resumes from 
the point where you saved the selected file. 

¢ Save: Choose Save to save the current game or setup 
to disk. Saved setups are represented by a Spy icon, 
and saved games by the Flag icon. 

¢ Save As...: Select Save As... to save the current setup 
or game to disk under a different name, and create a 
backup file. 

¢ Quit: When you choose Quit, you end the current game 
and exit to the Finder. 

17 



Edit Menu 
You use the Edit Menu to undo moves during play. 

¢ Undo Move: Select Undo Move to erase your last 
move. If your opponent has made a subsequent move, 
selecting Undo Move takes back both moves. The 
option is disabled when Undo Move is not appropriate. 

Game Menu 
Use the Game Menu to choose modes of play, your 
opponent's skill level, game rules, and preferences: 

¢ Demo Game: Runs a demonstration game in which the 
computer controls the pieces of both sides. 

¢ Single Game: Sets play to a single-game mode. Until 
you change to another mode, Single Game prevails each 
time you re-start play. 

¢ Campaign: Sets play to Campaign Mode. 
¢ Opponent Level: Allows you to set the playing ability of 

your computer opponent. 
¢ Standard Rules: Select to apply Standard Rules to play. 

¢ Tournament Rules: Displays a dialog to let you select 
rule variations for tournament play. 

¢ Preferences: Select to specify game and rule variations 
(see the Preferences section under PLAYING 
STRATEGO for more information). 

18 



A 
Options Menu | 
Use the Options Menu to select options affecting sound, 
piece movement and board display, and special items such 
as Instant Replay. 

Instant Replay: Select Instant Replay to review your 
opponent's last move. 
Start Game Over: Restores the current game to its 
initial setup, So you can replay it. 
Reveal All Pieces: Reveals the rank of all opponent’s 
pieces. When you select this option, you forfeit the 
current game. 
Sounds: Toggles game sounds and music on and off. 
Messages: Toggles error messages on and off; when 
selected, displays message in response to any illegal 
move. 
Drag Moves: If selected, releasing the mouse button 
when a moved piece is over a designated square con- 
firms the move; otherwise, you must click the button to 
set a piece in a square. 
Display Windows: Displays or hides the various game 
windows. 
Clean Up Windows: Restores any moved windows to 
their default position. 
Board...: Displays a dialog to let you change the game 
board and background pattern. 
Piece Set...: Displays a dialog allowing you to select a 
different piece set. 

19 
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WARRANTY 

ACO-4140 

ACCOLADE CUSTOMER SERVICE: (408) 296-8400 
If you need help with this — or any other — Accolade product, please give us a call 

between the hours of 8am and 5pm (Pacific Standard Time). Be sure you are at your 

computer when you call. We'll do everything we can to solve your problem or answer 

your question. Or write to us at: 

Accolade 
Attn: Customer Service 

550 S. Winchester Blvd., Suite 200 
San Jose, CA 95128 

If you have a modem, you can call and log-on to Accolade’s Bulletin Board for instant 

hints and other information. You can also leave questions about any Accolade game; 

they’ll be answered by Accolade’s technical support representatives. The number is 

408-296-8800. Our settings are 300, 1200, 2400 baud; 8 Data; No Parity; 1 Stop Bit. 

DO YOU WANT TO BACK-UP YOUR DISK? 
We know you're concerned about disk damage or failure. So feel free to make a 

back up of the game. See your computer manual for details about saving disks. If 

you lose the off-disk copy protection scheme, please send us $15 and we'll send you 

- anew one. If it’s destroyed, send us the remains, and we'll give you a replacement. 

YOUR DISK CARRIES A 90-DAY WARRANTY 
Accolade, Inc. warrants for a period of 90 days from the date of purchase by the 

original purchaser of the Software that the recording medium on which it is recorded 

will be free from defects in materials and workmanship. Defective media which has 

not been subjected to misuse, excessive wear or damage due to carelessness may 

be returned during the 90-day period without charge. 

After the 90-day period, defective media may be replaced in the United States for $10 

~ (plus 7.25% sales tax if the purchaser resides in California). Make checks payable to 

Accolade, Inc. and return to the address above. (To speed up processing, return only 

the disk, not other materials.) 

LICENSE AGREEMENT and LEGAL MUMBO JUMBO 
This computer software product (the “Software”) and the user manual are provided to 

the Customer under license from Accolade, Inc. and are subject to the following 

terms and conditions, to which the Customer agrees by opening the package of the 

Software and user manual and/or using the Software. Granting of this license does 

not transfer any right, title or interest in the Software or the user manual to the 

Customer except as expressly set forth in this License Agreement. 

The software and the user manual are copyrighted 1990 by Accolade, Inc. All rights 

are reserved. Neither the Software nor the user manual may be duplicated or copied 

for any reason. The customer may not transfer or resell the Software or user manual. 

All registered trademarks and names are properties of their respective owners. 

The remedies provided above are the Customer’s sole and exclusive remedies. In no 

event shall Accolade, Inc. be liable for any direct, indirect, special, incidental or con- 

sequential damages with respect to the Software or the user manual. Except as 

provided above, Accolade, Inc. makes no warranties, either express or implied, with 

respect to the Software or the user manual, and expressly disclaims all implied 

warranties, including, without limitation, the warranty of merchantability and of fitness 

for a particular purpose. 
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The best in entertainment software-" 8/90 





YOU’RE 
ABOUT TO 
DISCOVER 

If you just use your computer 
for spreadsheets or word pro- 
cessing or games, it’s time you 
started thinking about your 
computer in a whole new way. 

Because with the PRODIGY 
service, for one low monthly 
fee, you can get stock quotes 
almost as fast as your broker, 
using information provided by 
Dow Jones News / Retrieval... 
you can shop for virtually any- 

HUNDREDS OF NEW USES 
FOR YOUR 
COMPUTER. 
(And they’re all 
yours for one low 
flat monthly fee.) 

thing you need—with special 
savings and discounts just 
for members...you can find 
the lowest available airfares 
and book your own flights, 
hotels and rental cars... 
you can plan your trip with 
our 53-city version of the 

_ Mobil Travel Guide™... you can 
get Accu-Weather” Forecasts 
for over 300 cities worldwide... 
you can get sports scores even 

while games are in progress 
...your kids can have fun and 
learn with our educational 



features—including an online 
edition of the 21-volume 
Academic American 
Encyclopedia that’s updated 
quarterly...and when you bank 
online,* you can pay bills with- 
out writing checks and licking 
stamps, see your statement 
whenever you want, and 
transfer funds—even when 
the bank is closed. 

All for just $12.95 a month. 
Unlike other online services, 
the PRODIGY service doesn’t 
charge you by the minute. You 
can access the PRODIGY 
service (over regular phone 
lines) as often as you like, for 
as long as you like. The cost is 
just $12.95 a month, plus tax. 
And that’s for up to 6 members 
of your family. 

And now you can get a FREE 
PRODIGY © Service Start-up 
Kit and try the PRODIGY 
service RISK-FREE. 
Return the Order Card at the 
right, or call 1 800 776-0836, 
ext. 818, and we'll send you a 

PRODIGY Service Start-up Kit— 
with software and what 

you'll need to get started— 
absolutely FREE! 

Risk-Free Offer Terms 
Try the service for a month. 
If by some chance you're not 
completely satisfied during 
your trial month, simply mark 
your first bill “cancel”, return it 
and owe nothing. Otherwise, 
continue as a PRODIGY service 
member and pay just $12.95 
(plus tax) each month. What- 
ever your decision, the 
PRODIGY Service Start-up Kit 
is yours to keep—FREE. 

But be prepared. Because once 
you start using the PRODIGY 
service, you may not be able 
to live without it. 

*Banks may charge a fee for online banking. 

+x PRODIGY. 
Interactive Personal Service 

Finally, what the PC was invented for.” 



vetacn nere and Mall 

GET A FREE PRODIGY’ SERVICE 
START-UP KIT AND A MONTH OF 
THE PRODIGY SERVICE RISK-FREE. 
Complete this card, detach, and mail 
today. Or for faster delivery, call 
toll-free 1 800 776-0836, ext. 818. 
Your Free PRODIGY Service Start-up Kit includes 
PRODIGY ® software, easy-to-follow instructions, 
a Member handbook, a phone book containing 
numbers that enable you to connect to the service 
from anywhere in the country, and a guide to our 
exciting features. 

[_] Yes, send me a FREE PRODIGY Service Start-up Kit so I can 
begin my RISK-FREE trial of the service. I agree to the Offer Terms 
stated in this brochure. 

My computer system meets the requirements listed in this brochure. 
Send me PRODIGY® software for my: 

[_] 1BM® or compatible PC (includes 312” and 5!4“disks) (IB) —or— 

L_] Macintosh® computer (MC) 5000/5313 

Name 
(Please Print) 

Address 

Gy dE Se err a | | eee |) ee 

Signature - 

Home Phone ( ) 

Please allow approximately 2 weeks for shipment of your. PRODIGY Service Start-up Kit. 
Offer limited to one per household. 
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_ Copyright © 1990 Prodigy Services Company. All 

AIP890A 

To receive the PRODIGY service, your IBM” or 
compatible PC, or your Macintosh* ce pc 
must fit this description: 
IBM® PC, XT™, AT®, Personal System /2® family a products o or. 
one of the many compatible computers* with: 3 

i at least 512K memory and DOS version 2.0 or higher : 
li VGA/MCGA/EGA/CGA/Hercules™ or compatible graphics capability * 
ll one disk drive (3'2” or 514”) [i monochrome or color monitor 

— 1200 or 2400 bps Hayes® or compatible modem* 

If you have a color monitor and either a VGA or EGA graphics card, 
Tandy® 1000 series, IBM PS/2®, or a computer with a graphics adapter 
compatible with these, you will be able to view the PRODIGY service in 

lor. color. oa 

Macintosh® Plus, SE,  SE/30, II, Ix, lIcx, Ici or Portable 
computer with: 

minimum 1 mevabyte of RAM System software 41 or pees 
lf minimum one 800K disk drive 
Bf 1200 or 2400 bps Apple®, Hayes or ae modem* — 

If you have a Mac® II, IIx, Icx or IIci computer with a color monitor, ‘you : 
will be able to view the PRODIGY service in color. | 

*If you are unsure about your computer's capabilities, call us at 
1 800 776-0836, ext. 818 for assistance. 

~ PRODIGY service content and price subject to change. - 

PRODIGY is a registered service mark and trademark 
of Prodigy Services Company, a partnership of IBM 
and Sears. IBM, AT, PS/2 and Personal System /2 are 
registered trademarks, and XT is a trademark, of IBM 
Corporation. Hayes is a registered trademark of Hayes 
Microcomputer Products, Inc. Apple, Macintosh and 
Mac are registered trademarks of Apple Computer, 
Inc. Other product and service names are trademarks 
and service marks of their respective owners. 

Rights Reserved. 
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K, let’s review: Entertainment. In a world where life leaps 
around in bits and bytes, this should be a very important 

word in our everyday lexicon. Right? Absolutely. And 
good, stimulating ftun—yeah, fun—has always been 

what Accolade software irst, take a look at Accolade’s 

is all about. This year, it’s F widely acclaimed library of 

truer than ever before. SPORTS and DRIVING simula- 

tions. It is, quite simply, the best sporting line-up in the industry. © 

And with the sterling new addition of Jack Nicklaus’ Unlimited 

Golf & Course Design...well, it’s like nailing the 18th green 

with a monster 2-iron, then holing his year 

out for eagle. This golf simulation is also marks 

destined to become, like the Golden Accolade’s 

Bear himself, a legend in its own time. blazing entry 

into the imaginative world of the ANIMATED GRAPHIC ADVEN- 

TURE. Check out Search for the King and Altered Destiny, two 
titles that prom- ccolade launches into the STRATEGY 

ise to push this genre as well with two rockets: 

rapidly expand- Stratego, a stunning new computer 

ing category to version of one of the most popular 

new levels of strategy board games of all time, 
sophistication. and Star Control which combines 

deep strategy with white-hot, arcade-action tactical combat. 

nd then, when you're ready for something completely 

different, check out Chris Crawford’s Balance of the Planet, 

his “Earth Day” sequel to the run-away hit Balance of 

Power. Can you balance the world’s economic well-being 

without destroy- S oO go ahead. Flip a few pages. See what the 

ing the delicate best has to offer. The name of the game 

global ecology? is entertainment. And that’s Accolade. 



i FAR~ 
out is WATER BUNKER PATH TEE ROUGH 
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Create totally unique holes, or 
recreate golf’s greatest holes. Jack 
says: ‘| enjoy giving each hole its own 
character — adding bunkers, water, hills 
and trees to create strategic options. 
Legendary holes are not only beautiful or 
difficult — they also make golfers think.’ 

Play two pre-designed, ready-to-play 
courses. Trek across Muirfield Village, 
one of the Top Ten courses in the world and 
Site of Jack’s annual Memorial Tournament: 
and The Bear’s Track, a dream course 
designed by Jack exclusively for Accolade. 

Imagine being a golf god. Wave a wand, and fairwa 
rise from the earth. Lakes appear. Trees sprout and move — all magically, 
with push-button ease. Now come back to reality...and take a look 
at an amazing design program that lets you do all of that. 

i Jack 
/ i Stroke: i Pari = 

i Distance: 184% vcs. 
otal: Ey par 

Jack Nicklaus’ Unlimited Golf & Course Design™ combines the Play the game like you never have 
most realistic computer golf game available with an amazing Course before. Says Jack: “Instant-replays and 
Designer that gives you the power to create your own signature golf reverse-angle replays, updated statistics, 
courses. Course routing, bunker & pin placement, trees and other variable wind and course conditions, 
objects, slope, hills, water — virtually every aspect of golf course design _ plus faster drawing speeds make this 
is at your fingertips. the absolute standard in computer golf” 



When it comes to love and obsession, 
Les is more. More amusing, more out- 

rageous, more titillating. Being Les Manley, 
your secret crush on the luscious Stella 

Hart leads you on a whacked-out journey 
from here to Kingdom come. Find the 

clues. Then bring on the babes. 

It’s a three-ring circus out there, man. 
Literally. Manley’s quest takes you to some 

pretty exotic locales. Meet Luigi, The 
World’s Strongest Man. Then go to Las 
Vegas, the place that makes any circus 

seem like an afternoon in the library. 

Millions belies a tne ntertainer of all time. Millions 
more, it seems, are willing to capitalize on his fame. TV station WILL 

(corporate slogan: “If the networks won't show it, we sure as hell will") 
is one of the latter millions. Now you, as Les Manley, must Search Find the King, get a check. But first 

ou have to do a stint as a King imper- for the King™ in order to win the heart of your boss's secretary and 
Pee It can be brutal. Facocaly if (speaking of millions) a $1 million prize offered by WILL’s cynical 

you're good. Because there's a raging mob promotions department. 

or two out there. And they’d do anything 
to get a little closer to the King’s aura. 



Take a plunge into a parallel world. 
And we do mean plunge. Of course, being 
sucked into a fractal dimension is never 
easy. But exploring your A/tered Destiny 
is definitely worth a few moments of 
sheer shrieking terror. 

This is not Pittsburgh. It’s a world 
of odd vistas, and even odder inhabitants. 
We're talking very alien aesthetics. Some 
regions are magnificent, stunning. Others 
are positively postmodern, seemingly 
landscaped by the Dark Lord himself. 

boring. Hopelessly boring. Your own personal destiny seems to involve 
some meager investments and long days on a porch swing. Until one The scroll lady knows. But will 
day, you are sucked through your TV set into a bizarre, parallel universe. she tell you? Meet librarians and other 

Written by fiction-writer Mike Berlyn, A/tered Destiny™ features interesting people. Shrewdly extract infor- 
breathtaking graphics, and takes you on a wondrous adventure through —_ mation. It might also be good to avoid 
a fantasy world — assuredly unlike any you’ve seen before. Say grisly death or dismemberment. That would 
hello to Alnar the Metal Shaper. (But don’t shake his hand; it secretes not be a good destiny. 
acid). Meet Tentro, a thin but friendly creature. Steer clear of the 
thieving Kleegs. And definitely avoid The Howlers, odd disgusting slugs 
who swim beneath a lake of fog. 
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Jack Nicklaus’ Greatest 18 Holes of Major Cham- ¥@ 
pionship Golf™ lets you take on the Golden Bear on (3 
his choice of the most challenging 18 holes of major | 
championship golf in the world, as well as two other @ 

Nicklaus-designed courses. Play either stroke or (3 
“ skins” format. Tee off in a foursome... or go head- #3 

to-head with a computerized Jack Nicklaus! @ 

One reason why Nicklaus wins the Majors? He devours 
every hole. You can too with these aerial close-ups. 

Every lush detail: multiple tees, trees, fairways, 
rough, greens, hazards. Baltusrol for breakfast. 

Oakmont for lunch. 

The 16th at Kemper. Longest par 4 
on the course, water runs tee to green, 

and a huge bunker backs the pin. Need an 
adjective? How about hellacious? 

Jack Nicklaus Presents The Major Championship Courses of 
1989™ Play three grand slam courses of 1989. Includes Oak Hill 

Country Club, New York; Royal Troon Golf Club, Scotland; and 
Kemper Lakes Golf Club, Illinois. 



THE INTERNAT 

The 17th at St. Andrews. The toughest 
hole on the world’s oldest course. The 
infamous Road Hole starts out with a blind 
drive and ends with a fearsomely deep 
pot bunker. 

_ Australian Golf Club, Australia; Saint Creek Golf Club, Japan; and 
St. Mellion Golf & Country Club, England. 

The 3rd at St. Mellion. 
Veteran golf writers call it 
the finest tournament golf 
course in Europe. Slopes, 
mounds and nasty collection 
bunkers make this more like 
target practice than a walk 
in the English countryside. 

{ Michael 
1 fo) Stroke: 2 

a 1 Distance: ts 
fai nd! total: Ev 

JACK NICKLAUS JAC KLAUS PRESENTS THE MAJor CHAMPIONSHIP COURSES OF 1990 MEDINAH > SHOAL Moje ST ANDREW: 

Jack Nicklaus Presents 
The Major Championship 
Courses of 1990™ Three 
grand slam courses of 
1990. Includes Medinah 
#3, Illinois; St. Andrews, 

— Scotland; and Shoal 
Creek, Alabama 



HardBall l!™ retains the all-star qualities of the original. Effortless 
gameplay. Authentic graphics. Unparalleled realism. But now there’s 
more. Much more. More features and options. More frames of ani- 
mation. More choices, playability and true-to-ballplayer animation. 

Even more major league ballparks. And HardBall /I also updates 
and stores each of your player’s stats in virtually every category. 

HardBall ll has the features fans want. Like more offensive 
and defensive strategies, more base-running options, and more 

views of the playing field. Pull-down menus make managing easy. 
Construct your very own “dream team’ with the Team Editor 

feature, then compete in league play. HardBall /| even comes with 
its own “Instant Replay” feature. 

More of the world’s greatest courses for play on your Mean 78! 
Each volume contains three challenging courses for you to 

conquer. Famous Course Disk, Vol. Il contains Inverness Club, 
Ohio; Turnberry, Scotland; and Harbour Town, South Carolina. 

Famous Course Disks, Vols. Ill & IV contain Olympic Club, 
San Francisco; Las Colinas, Texas; Muirfield, Scotland; Doral, 
Florida; Castle Pines, Colorado; and Kapalua, Hawaii. Famous 

Course Disks, Vols. V & VI contain Butler National, Illinois: 
Bay Hill, Florida; Concord, New York; Medinah #3, Illinois; 

Riviera, California; Spyglass Hill, California. 



i 
Cortes ome face-to-face with 

heavyweight champion! 
Enter the ring with TKO™ 
and look straight into the 
yes of a fighter bent on 
nocking your block off. 
eal boxing. You can 
Ctually see the damage 
n each boxer: black eyes, 

fat lips, swollen cheeks. 

There’s nowhere to run. And nowhere 
to hide. Blow-by-blow stats provide a 
complete breakdown of each round. 

oted “Best Simulation” of 
986 by Software Publishers 
ssociation! Mean 18™ is golf 
S it should be, with life-like 
nimation and numerous 
strategy options. Play the 
gendary courses of Pebble 
each and St. Andrews or 

Jesign your own with the 
ourse Architect. Choose 
tween the pro and regulation 
ee...even ask the caddy to 

Choose the right club, then swing ggest your clubs! 
through. Feel the smooth deliberate 
backswing and compact follow-through. 
But it’s up to you to develop a rhythm 
and avoid that shank or hook. Up to four 
players can prove themselves in this 
world-class golf game. 



The Ferrari F-40™ and the Porsche 8599™ B@fh are capable 
of traveling 200 mph. Both are capable of nailing 60 mph in less 

than four seconds. Which car is king? The Duel: Test Drive II™ 
lets you find out. The world’s greatest production cars in head- 

to-head racing competition. “This game is a must have.” 
— Car & Driver Magazine 

Race 959 v. F-40, or go against the clock. Climb behind 
the wheel of the most technologically advanced supercars 

on earth. Rocket through bone-dry deserts, majestic mountains 
and lush forests. Contend with traffic, rocks, loose gravel, 

potholes, oil slick asphalt and—oh yeah—the cops. 

for the Mexican border. 

We supercars: Test Drive Il Car Disk™ Duel it out with five elite aaa 
Pm, apeed machines for your Test Drive Il, Includes the ’88 Lotus Turbo #aeten 

“™4 Esprit™ the Ferrari Testarossa™ the Porsche 911 RUF™ the '88 
Lamborghini Countach 5000S™ and the ’89 Corvette ZR1. 

European Challenge: Test Drive Il Scenery Disk.™ Here, driving is 
a passion, and speed limits are posted only to challenge the driver. 

Wind through the green meadows of the Netherlands. Blast by 
the beaches of the French Riviera. Descend into the mountainous 

valleys of Switzerland. Open it up on the world famous German 
Autobahn. (Caution: Snapshots may blur at 200 mph.) 
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California Challenge: Test Drive Il Scenery Disk.™ It’s a 
border-to-border race through the Golden State. Roar down 
the Redwood Highway, give it gas on the Golden Gate Bridge, 
drive by Devil’s Slide then motor through the Monterey 
Peninsula. Wave “adios” to LA’s freeways and make a run 

The Muscle Cars: Test Drive Il Car Disk.™ Here are five 
more street-scorching legends for The Duel. Includes the 63 
Corvette® Sting Ray “Split Window’ coupe, the ’68 Shelby 
GT500 Cobra® the 67 Pontiac GTO® the ’69 COPO 9560 
ZL-1 Camaro® and the ’69 Dodge Charger Daytona® 



3 Convenient Ways to Order Accolade Products: 
¢ See your favorite software retailer 
¢ Call 800-245-7744 
¢ Complete this form and return it to: 
Accolade, c/o StarPak, 237 22nd Street, 

Greeley, CO 80631 
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IBM PC/Tand oe ee Macintosh | sf 49.95] | 

ae IBM PC/Tand 
Blue Angels | 

{Bubble Ghost 

The Cycles 

*IBM/Tandy - please indicate disk size 
**Includes 5.25" & 3.5" disks 

Commodore 

IBM PC/Tandy 

Macintosh 



Day of The Viper Amiga 

Atari ST 

Dont Go Alone [IMC Tandy [3958 
The Duel: Test Drive II } See 

Apple IIGS 

Atari ST 

C64/128 

IBM PC/Tandy| 
Macintosh geereone| 

‘The Duel Scenery Disks: ae 

California Challenge Apple IIGS 

Atari ST 

C64/128 

Ne or 
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ce 

— \O Ol 
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European Challenge 

Apple IIGS 

Atari ST 
C64/128 ee 
IBM PC/Tandy ee aie 
Macintosh 

The Duel Car Disks: Amiga ae ao 

The Muscle Cars Apple IIGS a a 

Atari ST 

C64/128 14. 14.95] 

IBM PC/Tandy nat 21.95 
Macintosh 9/90 | 21.95) 

The Supercars Amiga 
Apple IIGS 
Atari ST 

C64/128 

*IBM/Tandy - please indicate disk size 



4th & Inches Amiga 

Apple IIGS 
C64/128 
IBM PC/Tandy 
Macintosh 
Amiga 

Apple IIGS 
C64/128 
IBM PC/Tandy 
Macintosh 

_ Amiga 

Apple IIGS 
C64/128 
IBM PC/Tandy 
Macintosh 
C64/128 
IBM PC/Tand 

The Game of 
Harmony 

Ath & Inches | 

Team Const. Disk | 

FrightMare 

Grand Prix Circuit 

Apple IIGS 
C64/128 
IBM PC/Tandy 
Macintosh 
Amiga 

IBM PC/Tand 
Amiga 

Apple IIGS 
Apple II Series 
C64/128 

HardBall! 
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C64/128 

IBM PC/Tand 

IBM PC/Tandy 

Macintosh 

Nicklaus Add-On Disks 

Course Disk, Vol. 1 Apple IIGS 

| C64/128 

IBM PC/Tandy 

Macintosh 

ata ete 

x Te, cuban 

8 —— _ >. P aa elacal 

Course Disk, Vol. 2 

Course Disk, Vol. 3 

IBM PC/Tandy 

Macintosh 

Ol 

*IBM/Tandy - please indicate disk size 
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Mean 18 Add-On Disks 
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IBM PC/Tand 

Pp fk fe fe | OO OO j= m opp [PB PB ho KO FO FLO FO FO FO JO Or FO. OT FOF OT [OT FOr 

Mini-Putt Apple IGS 
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In the great racing tradition of Accolade comes The Cycles: Inter- 
national Grand Prix Racing™ The Cycles wraps you around the 
chassis of the fastest bikes ever built as you compete in the Inter- 
national Grand Prix of motorcycle racing. Laguna Seca. Le Mans. 

Salzburg. Crisscross the globe to do battle with the world’s greatest 
racers in the sport’s premiere events. Who’s got the guts? Who 
wants the glory? Who'll hoist the trophy of world champion? 

[nee eee eee ee Feel the undeniable rush of full-throttle speed from a first- 

LAEEEEEEREEEEEEE person perspective. Experience true racing realism. Look over 
NANANA AANANAAA NA N the handlebars and see the pavement disappear under your wheels. 

LAAAANANS, Will the racer in front of you blast into the lead or dump his bike 
v trying? From Australia to Brazil, you'll file down the footpegs on the 

oo on. on a most grueling layouts in motorsports. 

The first-person perspective puts 
you at the helm of one of 4 authentic 
boat designs. Weather and water con- 
ditions vary, but today you lucked out — 
calm seas mean top speeds. Check your 
heading, compass, then bring the water 
to a boil. 

the wake offs 
Cing success, Accolade 
unches thunder on the 
ater. Heat Wave: Offshore 
uperboat Racing™ cap- 
ures the thrills of one 

__ Of the fastest growing 
__ Sports in America. Rooster- 

ail in four, 3-D Superboats. 
0 full-throttle at 100 
ph over oceans, rivers 

and canals as you battle 
O skippers for the title of 
S 1”: Best in the world. 



a MPUTER GAME eco 

Flccu 
| AA 
PELE TSO 

Now, a Classic 
comes to the computer 

screen! Stratego® 
is truly one of the 

greatest gameboard 
favorites of all time. 
Secretly deploy your 

army onto the battlefield. 
Your mission— protect 
your flag, and capture 

the enemy’s flag. Advance, 

Can you plot the perfect victory? 
Accolade’s adaptation of Stratego gives 
you all the features of the classic game, 

plus multiple game options and much more. 
Take on the computer. Plan your advance. 

Challenge the opposition. And capture 

attack boldly. .. but don’t the enemy flag. 
neglect your defense. 
The suspense builds 

as your men move deeper into ory, Move with caution and courage. W | r 
And remember: The next piece you attack could be a bomb. 

: : enol 

A\\) 

Marshal your forces 
wisely. Then lean 

hard on the trigger 
finger. Star Control 

combines deep strategy 
with arcade-action 

tactical combat. 
Construct and deploy 

your fleet. Explore new 
Stars. Build mines, colonies, 
fortifications. Select one of 

the nine strategic battle 
scenarios. Then brace 

for some of the hottest 
battle action you're likely 

to see on a computer 
screen. 

As veteran commander of an Alliance fleet of battle-cruisers, 
you've been dealing death to starships of the evil Hierarchy for 
years now. But the isolated skirmishes of years past are over. 

Engage now in a titanic struggle for control of the galaxy. Target 
the enemy’s home star system... but don’t leave yours unattended. 

Because in the yawning cavern of deep space, Star Control™ 
is everything. 
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Your whole life you’ve biown things 
up. Now it’s time to put it all together. 
You are a serene, spinning sphere, gliding 
through a world of multi-colored orbs, 
harmonious sounds and pulsating energy. 
Your goal? Bring like-colored spheres 
together to create ‘“‘synergy.’ The calmer 
you are, the further you'll go. 

Become the consummate Pick-up 
Artist. OK, their mothers warned them 
about guys like you. So it isn’t easy to 
charm 3 of the most tantalizing women in 
the bar. If you’re lucky, they may chat... 
even go out on a date. If you’re unlucky, 
the only thing you'll pick-up is the tab. 

Let’s face it: After a hard day, is beeping, blasting tension witat you 
want from your entertainment software? Or would you rather come 
home to Harmony™ — the game that challenges you to relax and offers 
soothing rewards for staying calm? You must “synergize” 50 unique 
configurations of musical, 3-D spheres and shapes — at your pace, 
with your touch, in your way. Hours and hours of engaging puzzles. 
The Game of Harmony is truly a New Age challenge. 

Cruise into the hottést bar 
in town. Bar Games™ sits 
you right down on your 
favorite stool as you par- 
take in 5 classic saloon 
games. Shake them bones 
with Liar’s Dice. Go on 
the make as the Pick-up 
Artist. Beat the local 
legends at Air Hockey. 
Take-in a wet t-shirt 
contest with Wet ’n Wild 
and serve suds to a thirsty 
mob in Last Call. 
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In light of looming ecological disaster, the United Nations has | ALANC E rae PLA 

appointed you High Commissioner of the Environment. Now you } 
have the power to levy taxes on industry and grant subsidies to | 
worthwhile causes. Can you balance the world’s economic well- } 

being with the vitality of the earth’s ecology? Balance of the Planet™ | 
incorporates a vast amount of critical, must-know information. } 

Get informed about acid rain, water pollution, nuclear accidents, j 
global warming, consumer goods. Then use your newly acquired | 

knowledge to save the planet from destruction. 

TO diferent 
factors, all inter- 
related. Just like 

real life. You can You fe Halt es 

raise the coal tax, for Epon te svt, Eup got can che 
example. Coal use 
is reduced, which 

reduces acid rain— 
thereby raising the quality 

of lake habitats, hence the global gene pool, ‘the accumulated 
wisdom of natural selection:’ Right choices save the biosphere; 
wrong oneg can turn it into a foul toxic soup. Hey, nobody said 

ecology was going to be easy. 

Dawn launch, South) Dakota, Stellar 
flight crews from around the globe 

gather on the tarmac to answer one 
question: Who is the world’s top 

bombing squadron? Strike Aces™ 
puts you in the cockpit of one of 6 

lethal strike aircraft. Lower the 
boom with the F-111F Aardvark, or 
Britain's Panavia Tornado. Rattle 

windows with the F-15 Strike Eagle, 
the fabulous F-4E Phantom, MiG 

27 Flogger or a Saab AJ37 Viggen. 
But it ain’t all fun & games. Because | 

7 of the world’s hottest inter- 
ceptors —Tomcats, Tigers, Falcons ; 

—are out there, hungry, waiting. | 

Experience the realism of 3-D 
olygon-fill technology and bit-map 
phics. Fluid flight. Painstaking details. 
6 built-in bombing missions, 16 sweat- 
aked sorties, taking out targets, taking 
on bogeys. Or create your own attack 

uns with the “Mission Design’ feature. 
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Strap yourself into 56 feet of sleek 
blue speed. Pilot an authentic Blue 
Angel F/A-18 with a realistic avionics 
system. Do maneuvers ‘til you're blue — 
delta rolls, fan breaks, left echelon rolls. 
Train in a'wire-frame flight simulator. 
Watch it all from a variety of camera angles. 
The choices are heavenly. 

Gunboat.™ Eight tons of firepower crammed into a 30-foot hull. 
For three decades, the Navy has deployed the river patrol boat (PBR) 
or the most hostile and claustrophobic type of war: River combat. 
n Gunboat you take on Colombian drug lords, Panamanian insur- 
yents, or renegade Viet Cong. They’re on the river. Around any 
end. Waiting. 

known as “RIVERINE 
OPERATIONS: Day 
and night, you get a first- 
person perspective from 4 

different battle stations. Soldiers, bridges, mines, docks, sampans, 
APCs and canyons are there in deadly detail. They swear the river 
will run red with your blood. But you've got a cute little .50 caliber 
M2HB machine gun that begs to differ. 

janeuvers that defy the laws 
f physics. Now you've made 
he team. Blue Angels Forma- 
on Flight Simulation™ takes 
ou from ground school to the 
ild blue yonder. You'll perform 
e actual air show maneuvers 
at have made the Blue Angels 
gends of the sky. 
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Since 2782 A.D., a war has raged between the planets of the 
Sun League and GAR, the ruthless master of a mechanoid race. 

Now his robotic army has seized a vital defense base in the Parin 
system. But there is hope. Day of the Viper™ puts you in control 

of a Viper-V unit, two tons of titanium vengeance. With it, you just 
may be able to infiltrate the heavily armed base and re-activate the 

defense computer. Good luck. GAR’s guys are looking to sizzle 
your Circuit boards. 

33 kinds of enemy 
robots, attacking [ie fz 
from 4 different & 

directions. That's 
right: GAR’s armored 
assassins are on the 
prowl, shooting first 
and interfacing later. 

The “multiple combat” 
feature places heavy 
metal killers only a 

bolo bomb away. Some robots are ponderous. Others, nimble. 
All are deadly. Activate shields and weapons, lock-on target, and 

melt a few mainframes, man. 

Eiteerress MOUSE SUTTON TO CONTINUE. [Enauusmam 

i ne “% ay es J i B [Bie ¥ Ye. pe 

Be 

 ALON® 
Want to go some place really scary? Then journey to the haunted SCOGEBUE 

house on the hill. Grandfather went mad trying to solve its mysteries. 
Now you, joined by an expert team of polter-professionals are 

destined to explore this enormous “fortress of fright” and unlock 
its dark secrets. But remember... DON’T GO ALONE.™ 
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Your code name: Moondancer, mdster spy. Your mission: recover 
stolen NATO defense plans. Two of the three NATO couriers who 
were handcuffed to the plans now lie on marble slabs in a morgue. 
And Moscow is about to do a power lunch with the assassin. 
The trail leads to Berlin...and The Third Courier™ 

Be all the spy you can be. In Berlin, talk to everyone. Trust 
no one. Each confrontation is critical. The next citizen could 
provide a vital clue or connection. See a Berlin the tour bus misses — 
the legendary city known for intrigue, espionage and one heck of a wall. 

A huge haunted house with monster- 
laden levels of play. The depth of this 
game is scary. Explore complex, multi- 
level mazes as you battle more than 100 
spooks, spirits and things that go bump 
in the night. The breakthrough interface 
gives the beginner a ghost of a chance, 
yet still challenges the most experienced 
role player. 
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